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Getting Started with 
Zoom 
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Activating Your Zoom Account and Logging in 
to Zoom 

This article covers how faculty, staff, and students can activate their Zoom 
account and access Zoom on the web. 

1. Log in to your campus portal and click Web Meetings. 

View detailed instructions on accessing your portal. 

1. Click on the Web Meetings portal app. 
2. Notice if you search for "zoom" in the search box, the portal will bring up the 

Web Meetings app. 

2. Click on the Log in to Zoom button. 
You can access the CSUF Zoom webpage directly as well. 
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Notice there are links to training materials and a button to access the Zoom 
Download Center on this page. 

3. Your Zoom account is now activated and you are signed in 
to the Zoom web application. 
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You can now use the Zoom web application to schedule meetings or modify your 
settings. 

Need More Help? 
Faculty/Staff - contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777. 

Students - contact the Student IT Help Desk at StudentITHelpDesk@fullerton.edu or 
657-278-8888. 

View the Zoom Help & Resources article. 
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Downloading the Zoom Desktop Client 

This article covers how to download the Zoom desktop client and sign in with 
your account. 

NOTE: You must have an active CSUF Zoom account prior to following these steps. 
Please view the article on activating your account if you have not activated your 
account. 

1. Open your browser to https://fullerton.zoom.us/download 

Open your browser to https://fullerton.zoom.us/download. 
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2. Click on the Download button under Zoom Client for 
Meetings. 

3. Once you open the installer, you may see a security 
warning. Click Run. 
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4. After the installer finishes, click Sign In. 

5. Click Sign In with SSO. 

Click Sign In with SSO to sign in with your CSUF username and password. 

NOTE: If you are already signed in to the Zoom web application, you may be 
automatically signed in to the Zoom desktop client. 
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6. Enter fullerton as the company domain and then click 
Continue. 

1. Enter fullerton as the company domain. 
2. Then click Continue. 
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7. Enter your campus username and password. Then click 
Sign In. 
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8. After a moment, the Zoom client will sign you in and you're 
ready to go! 

Need More Help? 
Faculty/Staff - contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777. 

Students - contact the Student IT Help Desk at StudentITHelpDesk@fullerton.edu or 
657-278-8888. 

View the Zoom Help & Resources article. 

Created by LAC 
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Downloading the Zoom Outlook Plug-In 

This article covers how to download the Zoom Outlook plug-in which allows you 
to schedule Zoom meetings using Microsoft Outlook. 

Choose your computer type 

I am using a PC (Windows) 

1. Open your browser to the Zoom Download Center. 

Open your browser to the Zoom Download Center. 
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2. Scroll down and click on the Download button under Zoom Plugin 
for Microsoft Outlook. 

3. The wizard starts. Click Next. 
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NOTE: You may want to close Outlook if you have it open. 

4. Click Next. 

It is recommended that you allow Zoom to install in the default location. Simply click 
Next. 

5. Click Next to confirm the installation. 

You may get a message asking you to confirm that you want to install this on your 
machine. 
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6. Click Close. 
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NOTE: If you did not close Outlook before starting this wizard, you will need to close 
Outlook and then re-open it for the plug-in to show up. 

7. You should now see a Zoom section in Outlook. 

 You may need to have the Zoom Desktop client installed on your computer 
to schedule meetings in Outlook. 

You can now schedule a meeting or start an instant meeting directly from Outlook. 

I am using a Mac 

1. Open Microsoft Outlook and click Get Add Ins. 
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2. Search for Zoom to find the Zoom for Outlook add-in. Click Add. 

 Note that even though the add-in indicates an additional purchase is 
required, you will not have to pay for this add-in as CSUF has a license. 
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3. Click Continue. 

4. Close the Add-ins for Outlook screen by clicking the red button at 
the top left. 
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5. Open a new meeting request. Click Add a Zoom meeting. 
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6. Click SSO to sign in to Zoom with your CSUF account. 
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7. Enter Fullerton as the company domain. Click Continue. 
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8. Enter your campus username and password. Then click Login. 

9. Zoom will add a Zoom meeting to your calendar invite. You're all 
set! You can continue creating the meeting or cancel it if you don't 
need to schedule a Zoom meeting at the moment. 

 You may notice that the "Zoom is working on your Add a Zoom Meeting 
request" message keeps spinning. This is okay. The Zoom meeting will still 
work. 
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Need More Help? 
Faculty/Staff - contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777. 

Students - contact the Student IT Help Desk at StudentITHelpDesk@fullerton.edu or 
657-278-8888. 

View the Zoom Help & Resources article. 
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Taking Attendance in a Zoom Meeting 

This article covers how faculty can take attendance in a Zoom meeting. 

 Please note that the attendance report is available 30 minutes after a 
meeting is ended. 

1. Log in to Zoom on the web. 
View detailed instructions on accessing Zoom on the web. 

2. Click Reports and then choose Usage. 

3. Check that the date range at the top includes the session 
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for which you want to take attendance. Then click on the 
Participants link for the session. 

1. Check that the date range includes the date of the session for which you want to 
take attendance. If not, adjust the date range and click Search. 

2. Then click the Participants link for the session. 

4. Review the report. Check the Export with meeting data 
checkbox. 

 You can choose to export the report without the meeting data, but it's 
recommended that you include it to avoid confusion if you download 
multiple reports. 
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1. Notice that the same student joined the meeting twice. This happens when a 
student leaves the meeting and re-joins it. You won't be able to tell if they left the 
meeting because of technical difficulties, but you can see how long they were in 
the meeting under Duration. 

2. Click Export with meeting data. 

4.1. Click Show Unique users to see a collapsed list of each unique 
attendee and their total duration. 

 The Total Duration includes the total amount of time the student spent in 
the meeting even if they left/rejoined several times. 
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5. Click Export. 

6. An Excel file will download to your computer. Open the 
Excel file. 

 You can click File > Save As to save this report with a new name and in Excel 
(.xlsx) format. 

Need More Help? 
Faculty/Staff - contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777. 
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View the Zoom Help & Resources article 
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Creating a Secure Meeting in Zoom 

This article covers how CSUF faculty, staff, and students can create more secure 
meetings in Zoom. 

1. Log in to Zoom (either on the web or the desktop client). 
View more detailed information on how to log in to Zoom on the web. 

View information on downloading the Zoom desktop client. 

2. Click Schedule a New Meeting. 

 In the desktop client, simply click Schedule on the Home tab. 
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3. To keep the meeting secure, choose to generate the 
meeting ID automatically, and set a password for the 
meeting. 

4. Turn off participant videos, disable join before host, and 
choose only authenticated users can join. Optionally, you can 
enable the waiting room. 

 In the desktop client, you will need to click Advanced Options to view and 
modify these settings. 
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1. Turn off the Video for participants. Participants will still be able to use video if 
needed, but the video option is turned off when a participant joins the meeting. 

2. Uncheck the Enable join before host option. You should not allow anyone to 
join the meeting before you have started it. 

3. Always check Mute participants upon entry. Participants will still be able to use 
their audio to speak if needed, but they will be muted when they join the 
meeting. 

4. Optional: check Enable waiting room to place attendees in a waiting room when 
they join. NOTE if you do this, you will need to manually admit each attendee into 
the meeting. This adds security to the meeting, but if you have over a hundred 
attendees, you may not want to enable the waiting room. 

5. Always check Only authenticated users can join. This means that users must 
have a Zoom account in order to join the meeting. This keeps "guest" accounts 
from joining your meeting. 

Need More Help? 
Faculty/Staff - contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777. 

Students - contact the Student IT Help Desk at StudentITHelpDesk@fullerton.edu or 
657-278-8888. 
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View the Zoom Help & Resources article. 
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Using Dual Monitors in Zoom 

This article covers how to enable the use of dual monitors in Zoom. 

 You will need to use the Zoom Desktop app for this setting and for your 
meetings. View information on how to download the Zoom desktop client. 

1. Open the Zoom Desktop client and click on the Settings 
icon on the Home tab. 
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1.1. If you're not on the Home tab, you can click on your profile 
picture and then select Settings. 

A. Click on your profile picture. 
B. Then click Settings. 
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2. Place a checkmark next to Use dual monitors in the 
General section. 

3. You're done! As long as you use the Zoom desktop app, the 
dual monitors feature will be enabled for all future Zoom 
meetings. 

 Notice that Zoom automatically checks the Enter full screen automatically 
when starting or joining a meeting option for you. You can un-check this 
option if you wish, but using dual monitors may work better in full screen 
mode. 
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4. When you join or start a meeting, one monitor will contain 
the meeting controls and participants' video. The other 
monitor will just contain participants' video. When you start 
sharing your screen, you will still see the meeting controls 
and participants' video on one monitor and the content you 
are sharing on the other monitor. 

Image above from Using Dual Monitors article by Zoom Support 

Need More Help? 
Faculty/Staff - contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777. 

Students - contact the Student IT Help Desk at StudentITHelpDesk@fullerton.edu or 
657-278-8888. 

View the Zoom Help & Resources article. 
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Viewing and Changing Your Zoom Host Key 

This article covers how Zoom meeting hosts can view or change their host key in 
Zoom. 

The host key is a 6-digit PIN used to claim host when calling in via telephone. 
View more about using your host key. 

1. Log in to Zoom on the web. 
View detailed instructions on accessing Zoom on the web. 

2. Click on Profile. 

3. Scroll down to the Host Key. Click Show to view your 
current Host Key. 
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4. Click Edit to change your Host Key. 

5. Enter a new 6 digit Host Key. Click Save. 

 Note that Zoom will not allow you to pick a simple host key such as 123456 
or 111111. You should also not use the one in the screenshot below as it is in 
a publicly available document. 

6. You're done! You may want to click Hide to hide your new 
host key. 

Need More Help? 
Faculty/Staff - contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777. 

Students - contact the Student IT Help Desk at StudentITHelpDesk@fullerton.edu or 
657-278-8888. 

View the Zoom Help & Resources article. 
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Video: CSUF Zoom Quick Start for Faculty 

This article contains a link to a quick start video for faculty on scheduling Zoom 
meetings, communicating Zoom meeting information to students, starting a 
Zoom meeting, and sharing a PowerPoint with a Zoom meeting. 

View the CSUF Zoom Quick Start for Faculty video 

Need More Help? 
Faculty/Staff - contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777. 

View the Zoom Help & Resources article 
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Video: CSUF Zoom: How Students Join a 
Meeting 

This article contains a link to a quick start video for students on joining a Zoom 
meeting created by an instructor. 

View the CSUF Zoom: How Students Join a Meeting video. 

Need More Help? 
Students - contact the Student IT Help Desk at StudentITHelpDesk@fullerton.edu or 
657-278-8888. 

View the Zoom Help & Resources article 
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Video: CSUF Zoom: Creating a Secure Meeting 

This article contains a link to a quick video on securing your Zoom meeting. 

View the CSUF Zoom: Enabling Authentication for Meetings video. 

Need More Help? 
Faculty/Staff - contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777. 

Students - contact the Student IT Help Desk at StudentITHelpDesk@fullerton.edu or 
657-278-8888. 

View the Zoom Help & Resources article 

Page 43Zoom // Downloaded: 09-22-2020 // Disclaimer: This document is only valid as of the day/time when it is
downloaded. Please view the original web document for the current version.

http://www.fullerton.edu/ittraining/software/zoom/tutorials/Zoom_SecureMeeting/
mailto:helpdesk@fullerton.edu
mailto:StudentITHelpDesk@fullerton.edu


Zoom Help & Resources 

This article contains help and resources for the Zoom web conferencing tool. 

CSUF Zoom Resources 
CSUF IT Zoom page: contains information and links to information for CSUF users. 

Zoom Tutorials and Guides 
The following are training and support materials from Zoom: 

• Main Zoom support page 
• Getting Started 
• Zoom training tutorials 
• Zoom YouTube channel 

Need More Help? 
Faculty/Staff - contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777. 

Students - contact the Student IT Help Desk at StudentITHelpDesk@fullerton.edu or 
657-278-8888. 
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Using Zoom with 
Titanium 
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Instructors: How to Set Up a Zoom Meeting in 
Your Titanium Course 

This article covers how instructors can add a Zoom meeting to a Titanium course 
and the permissions you can control in Titanium. 

NOTE: It is highly recommended that you activate your Zoom account and download 
the Zoom desktop client before adding a Zoom meeting to your Titanium course. 

1. After turning editing on in your Titanium course, click Add 
an activity or resource. 

Click on Add an activity or resource in the section where you want the Zoom 
meeting to appear. 
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2. Select External Tool and then click Add. 

3. Enter the activity name. 

NOTE: You may wish to put "Zoom" in the activity name to let your students know that it 
is a Zoom meeting. 
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4. Select Zoom from the External tool type drop-down menu. 

5. Choose how you want to launch the meeting from the 
Launch container drop-down menu. 
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6. If you want to add restrictions, click on Restrict Access and 
then click Add restriction... 

1. Click on Restrict Access to expand the menu. 
2. Click Add restriction... 

6.1. A common restriction you might use is restricting access to the 
Zoom meeting before/after a certain day and time. 

Keep in mind that your students will not see the Zoom meeting in Titanium before/
after the restriction day/time. For example, in the screenshot above, students would 
not be able to see the Zoom meeting in Titanium until July 27th, 2016 at 4pm. 

7. If you are ready to set up your Zoom meeting now, click 
Save and display. If you want to set it up later, click Save and 
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return to course. 

1. To open your Zoom meeting now, click Save and display. 
2. To open your Zoom meeting later, click Save and return to course. 

NOTE: Students will not be able to access the Zoom meeting until you open it. If you want 
students to be able to join the meeting before you do, you will need to open the Zoom 
meeting sometime before the meeting day/time (e.g. a few days before or 30 minutes 
before). 
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7.1. When you open the Zoom meeting, click Launch Application. 

1. Click Launch Application when the pop-up window appears. 
2. If the pop-up window does not appear, scroll down in the Zoom meeting window 

and click download & run Zoom. 

NOTE: Based on the browser you are using, you should see instructions on the screen that 
are specific to your browser. In this article, Google Chrome is the browser shown. 
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7.2. If you are using your computer's audio, click Test Computer 
Audio to set up your microphone and speakers. 

You can test your computer's audio and set up your microphone/headset/speakers 
by clicking on Test Computer Audio. 
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7.3. You can now modify some of the meeting settings in order to 
prepare for the meeting. 

You should be able to modify settings such as "mute participants on entry" and 
restrict screen sharing. 

NOTE: Zoom meetings created in Titanium are technically "instant meetings" as opposed 
to "scheduled meetings." This will mean you do not have as much control over the 
meeting as you would if you scheduled the meeting. For example, you cannot restrict 
students from showing video automatically. You can, however, turn off an individual's 
video during the meeting. 
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7.4. If you want to leave the meeting open so students can join the 
meeting before you arrive, click Leave Meeting. 

To leave the meeting open so students can join it before you arrive, click Leave 
Meeting. 

NOTE: if you choose End Meeting for All, students will not be able to join the meeting 
before you do. Also, you may lose some of the meeting settings that you just added (e.g. 
mute all participants on entry). 

One suggestion would be to use the restrictions in step 6 to hide the Zoom meeting from 
your students. That way, you can set up your Zoom meeting now and leave it running but 
students will not be able to join until the day/time of the meeting. 
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8. Join the meeting from Titanium when you are ready to 
start the meeting. 

8.1. You will receive an email if any students join the meeting before 
you do. 

You can click on the URL in this email to join the meeting in progress or go to 
Titanium to join the meeting. 
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9. Click on Launch Application. 

Click Launch Application when the pop-up window appears. 

NOTE: Based on the browser you are using, you should see instructions on the screen that 
are specific to your browser. In this article, Google Chrome is the browser shown. 
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10. Choose your audio option to finish joining the meeting. If 
joining by computer audio, click Test Computer Mic & 
Speakers to set up your audio. 

1. Choose your audio option for the meeting: Join by Phone or Join Audio 
Conference by Computer. 

2. If you join by computer, click Test Computer Mic and Speakers to set up and 
test your microphone and speakers. 

NOTE: If you choose to join by phone, you will be given a phone number to call for the 
audio and you will be logged into the Zoom meeting for visuals only. The audio will be the 
same on the phone as it is on the computer so you do not need to join both phone and 
computer audio for students to be able to hear you. 
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11. You're now in the meeting! 

If any students have already joined the meeting, you will see them in the Manage 
Participants section. 

Need More Help? 
Faculty/Staff - contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777. 

Students - contact the Student IT Help Desk at StudentITHelpDesk@fullerton.edu or 
657-278-8888. 

View the Zoom Help & Resources article 

View Titanium Resource Center articles 

Created by LAC 

Duplicated TRC 
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Students: How to Join a Zoom Meeting in Your 
Titanium Course 

This article covers how CSUF students can join a Zoom meeting that has been 
added to a course in Titanium/Moodle by the instructor. 

NOTE: For best results, students may want to activate their Zoom account and 
download the Zoom client prior to the meeting. 

1. Click on the Zoom meeting in your Titanium course. 
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2. A Zoom launcher window should automatically open. Click 
Save File. 

Click Save File when the Zoom launcher window appears. 

NOTE: Based on the browser you are using, you should see instructions on the screen that 
are specific to your browser. In this article, Mozilla Firefox is the browser shown. 

2.1. If the launcher window does not open, scroll down in the Zoom 
meeting window and click on the download here link. 

Scroll down in the Zoom meeting window and click download here if the Zoom 
launcher does not automatically start. 
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2.2. If you already have the Zoom desktop client installed, you can 
select Zoom Meetings and then click OK to launch Zoom. 

1. Select Zoom Meetings in the pop-up window. 
2. If you want to automatically launch the Zoom desktop client for all Zoom 

meetings on this computer, place a checkmark next to Remember my choice for 
zoommtg links. 

3. Click OK. 

You can now skip to step 6 in this guide. 
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3. Locate the downloaded file and double click on it to run 
the Zoom launcher. 

1. Locate the downloaded file either on your desktop or in the downloads area of 
your browser. 

2. Double click on Zoom_launcher.exe. 

NOTE: Based on the browser you are using, you should see instructions on the screen that 
are specific to your browser. In this article, Mozilla Firefox is the browser shown. 
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4. Click Run if you receive a security warning pop-up 
message. 

5. After Zoom has been installed, enter your name and then 
click Join. 

1. Enter your name in the Your Name field. 
2. Click Join. 
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NOTE: If you have already activated your Zoom account and downloaded the Zoom 
desktop client, you should automatically be signed in to the Zoom meeting with your 
name already populated. 

6. Choose your audio option to finish joining the meeting. If 
joining by computer audio, click Test Computer Mic & 
Speakers to set up your audio. 

1. Choose your audio option for the meeting: Join by Phone or Join Audio 
Conference by Computer. 

2. If you join by computer, click Test Computer Mic and Speakers to set up and 
test your microphone and speakers. 

NOTE: If you choose to join by phone, you will be given a phone number to call for the 
audio and you will be logged into the Zoom meeting for visuals only. 
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7. You're now in the meeting! 

As long as your instructor allows it, you can join the meeting early. If not, you will 
need to wait until the instructor opens the meeting before you can join. The 
instructor may restrict your access to some Zoom features like screen sharing and 
microphone access. 

Need More Help? 
Faculty/Staff - contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777. 

Students - contact the Student IT Help Desk at StudentITHelpDesk@fullerton.edu or 
657-278-8888. 

View the Zoom Help & Resources article 

View Titanium Resource Center articles 

Created by LAC 

Duplicated TRC 
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Zoom HIPAA Subaccount 
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Activating Your Zoom HIPAA Account 

This article covers how approved users can activate their CSUF Zoom account on 
the HIPAA subaccount which offers additional protections for HIPAA-related 
interactions. 

What can I expect with a Zoom HIPAA Account? 
Under the U.S. Health Insurance Portability and Accountability Act of 1996, a HIPAA 
business associate agreement (BAA) is a contract between a HIPAA covered entity 
and a HIPAA business associate (BA). The contract protects personal health 
information (PHI) in accordance with HIPAA guidelines. 

Keep in mind that changing an existing Zoom user account to a HIPAA-compliant 
account will restrict some of the current features of the Zoom account. 

• End-To-End Encryption enabled for the meetings you schedule 
• Cloud Recording will be disabled for the meetings you schedule. 
• User information removed from Zoom reports for all meetings you schedule 
• Encrypted Chat enabled. (Screen capture and image transfer are disabled in Chat) 

For more information, view the Zoom HIPAA Compliance Guide (PDF). 

 These HIPAA-compliant features are enabled only for Zoom meetings 
scheduled by a HIPAA account.  If you attend a meeting scheduled by 
someone else who uses non-HIPAA Zoom account, the security features are 
NOT enabled for that call. 
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1. Log in to your campus portal and click Web Meetings. 

View detailed instructions on accessing your portal. 

1. Click on the Web Meetings portal app. 
2. Notice if you search for "zoom" in the search box, the portal will bring up the 

Web Meetings app. 

2. Click on the CSUF Zoom Sign In button. 

 You can access the CSUF Zoom webpage directly as well. 
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3. Click Switch to the New Account. 
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4. Click I Acknowledge and Switch. 

5. You'll see a notification that an email was sent to your 
email address. 
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6. Locate and open the email from Zoom. Click Switch to the 
new account. 
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7. Click I Acknowledge and Switch. 

8. Click Sign in Now. 
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9. You're done! Your Zoom account has been updated to the 
HIPAA subaccount. 

Need More Help? 
Faculty/Staff - contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777. 

Students - contact the Student IT Help Desk at StudentITHelpDesk@fullerton.edu or 
657-278-8888. 

View the Zoom Help & Resources article. 
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Zoom Webinars 
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Requesting and Using a Zoom Webinar 

This article covers how CSUF faculty, staff, and students can request a Zoom 
webinar and links to information on how to use the Zoom Webinar. 

What is a Zoom Webinar? 
A Zoom webinar allows you to host interactive, large-scale events online for up to 
3,000 attendees. 

View more information on Zoom Webinars at the Zoom Support site. 

 Please note that not all Zoom Webinar features are available with the CSUF 
Zoom license. 

How do I request a Zoom Webinar? 
Faculty/Staff: to learn more about webinar setup and functionality, contact IT Help 
Desk at helpdesk@fullerton.edu at least three weeks prior to your planned event. 

Students who are interested in creating a webinar must ask a faculty/staff sponsor 
to contact IT Help Desk on their behalf. 

How do I get access to schedule Zoom Webinars for my 
department? 
There are a limited number of webinar licenses, so faculty and staff should contact 
the IT Help Desk at helpdesk@fullerton.edu to determine how to best meet their 
needs. 
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How do I use a Zoom Webinar once it's scheduled? 
When your webinar is scheduled, you will receive a notification with the link/URL to 
join the webinar. You can join the webinar by clicking on the link/URL or, if you have 
your Zoom desktop client connected to your Outlook, you can click the Join button in 
the desktop client. 

Additional Information 

Roles in a webinar (includes what features/controls each role has access to in a 
webinar) 

Webinar practice session 

Managing participants in a webinar 

Using webinar chat 

Polling for webinars 

Getting started with Question & Answer 

View all Zoom Webinar articles 

What can attendees do in a Zoom Webinar? 
When setting up your Zoom Webinar with the IT Help Desk, you will let them know 
which features you want enabled for attendees in the webinar. 

Joining and participating in a webinar (attendee) 

Raising your hand in a webinar 

Using webinar chat 

Need More Help? 
Faculty/Staff - contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777. 

View the Zoom Help & Resources article. 
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